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Abstract. Coral reefs serve as natural barriers that protect adjacent shorelines from coastal hazards such as storms, waves 

and erosion. Projections indicate global degradation of coral reefs due to anthropogenic impacts and climate change will 10 

cause a transition to net erosion by mid-century. Here, we provide a comprehensive assessment of the combined effect of all 

of the processes affecting seafloor accretion and erosion by measuring changes in seafloor elevation and volume for 5 coral 

reef ecosystems in the Atlantic, Pacific and Caribbean over the last several decades. Regional-scale mean elevation and 

volume losses were observed at all 5 study sites and in 78% of the 59 individual habitats that we examined across all study 

sites. We estimate that 12% to 65% of seafloor elevation loss may be attributed to reduced carbonate production, bioerosion 15 

and carbonate dissolution and 35% to 88% may be attributed to physical erosion and export of sediment from these systems. 

Erosion of both coral-dominated substrate and non-coral substrate suggests that the current rate of carbonate production is no 

longer sufficient to support net accretion of coral reefs or adjacent habitats. We show that regional-scale loss of seafloor 

elevation and volume has accelerated the rate of relative sea level rise in these regions. Current water depths have increased 

to levels not predicted until near the year 2100, placing these ecosystems and nearby communities at elevated and 20 

accelerating risk to coastal hazards. Our results set a new baseline for projecting future impacts to coastal communities 

resulting from degradation of coral reef systems and associated losses of natural and socio-economic resources. 

1 Introduction 

Coral reef ecosystems develop over thousands of years as organisms build skeletons of calcium carbonate minerals that form 

complex 3-dimensional structures, and keep pace with rising sea level through continued growth and accretion of carbonate 25 

sediments. These ecosystems support up to 25% of fisheries in tropical regions and developing nations (Garcia and Moreno, 

2003), and economic and recreational services for more than 100 countries (Burke et al., 2011). Reef framework and 

shallow, non-coral-dominated habitats serve as natural barriers that protect shoreline ecosystems and coastal communities by 

reducing hazards from waves, storm surges and tsunamis for more than 200 million people around the world (Sheppard et 

al., 2005; Ferrario et al., 2014). Local and global, natural and human-induced stressors have caused the loss of reef-building 30 
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organisms and reef structure, a decrease in biodiversity, a transition to algal-dominated communities (Pandolfi et al., 2003), 

and an increase of bioerosion (Alvarez-Filip et al., 2009), placing coral reefs around the world in a state of rapid decline 

(Madin and Madin, 2015).   

 

Coral reef degradation and the causes have been well documented since the 1970’s (Gardner et al., 2003) when regional-5 

scale species compositions that remained stable throughout the Pleistocene and Holocene began changing (Aronson et al., 

2002). Most reef degradation has been attributed primarily to impacts of coastal development, overfishing, pollution, nutrient 

enrichment, coral bleaching and disease (Glynn, 1984; Greenstein et al., 1998). Abundance of reef-building corals has 

decreased as much as 72% since 1968 on Pacific reefs and as much as 50% since 1970 on many Caribbean reefs (Gardner et 

al., 2003; Bruno and Selig, 2007; 2014; Jackson et al., 2014). Carbonate production rates have decreased to below historical 10 

values on Caribbean reefs and carbonate-budget models indicate that some are already experiencing net erosion (Perry et al., 

2013). Projections indicate up to 66% of coral reefs worldwide will continue to degrade in the next few decades due to ocean 

warming and acidification from unprecedented rates of global climate change (Frieler et al., 2013) that may cause reef 

erosion to exceed accretion (Hoegh-Guldberg et al., 2007). Ancient reef crises linked to global climate change during the 

past 500 million years are marked in the geologic record by major decreases in carbonate accretion and reef volume 15 

(Kiessling and Simpson, 2011).  

 

Numerous studies have modeled reef- to regional-scale accretion and erosion on coral reefs based solely on carbonate 

budgets some of which account for rates of bioerosion (Stearn, 1977; Brock, 2006; Moses, 2009; Kennedy et al., 2013; Leon, 

2013a; Perry et al., 2013; Perry et al., 2014; Perry, 2015). Recent studies have also measured regional-scale chemical erosion 20 

of carbonates due to dissolution caused by ocean acidification (Brock, 2006; Moses, 2009; Muehllehner, 2016). Very few 

studies have quantified sediment transport and export on reef systems (Kench, 2004; Morgan, 2014). Such studies are 

essential for attributing ecosystem change to cause, setting target levels for restoring and maintaining healthy reefs (Kennedy 

et al., 2013) and for measuring and predicting reef degradation due to these specific process rates. However, no prior studies 

provide a comprehensive assessment of total seafloor elevation and volume change due to the combined effect of all of the 25 

processes affecting seafloor accretion and erosion (i.e., including physical erosion; redistribution, import or export of 

seafloor sediments; compaction; direct human alterations to the seafloor, carbonate production, bioerosion, chemical 

erosion). Vertical accretion or erosion of coral reef ecosystems is a function of total mass balance (Schlager, 1981). 

Therefore, measures of total system change in seafloor elevation and volume are required to accurately assess and predict the 

impact of reef degradation on the vulnerability of coastal communities to hazards caused by storms, waves, sea level rise and 30 

erosion. 

 

Here, we quantify the combined effect of all constructive and destructive processes on modern coral reef ecosystems by 

measuring regional-scale changes in seafloor elevation. We assessed 5 coral reef ecosystems in the Atlantic (Upper and 
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Lower Florida Keys), Caribbean (U.S. Virgin Islands), and Pacific (Maui, Hawaii) including both coral-dominated habitats 

and adjacent, non-coral dominated habitats. We adapted an elevation-change analysis method that has traditionally been used 

to monitor seafloor changes such as sediment accretion and erosion, and migration of shipping channels, sand bars, mud 

banks and other seafloor features in coastal environments (Byrnes et al., 2002; Taylor and Purkis, 2012; Byrnes et al., 2013) 

and we present results from the first application of this method to coral reef ecosystems. We used historical bathymetric data 5 

from the 1930’s to 1980’s and contemporary Light Detection and Ranging (LiDAR) digital elevation models (DEMs) from 

the late 1990’s to 2000’s to calculate changes in seafloor elevation for each study site (Tables S1 & S2) over time periods 

reflecting low to high anthropogenic impact (Table S3). We then created elevation-difference models from which we 

calculated corresponding changes in seafloor volume for whole study sites and for habitat types within each site. The 

magnitude of erosion that has already occurred, trajectories for continued coral reef degradation (Kennedy et al., 2013) and 10 

increasing sea level place these ecosystems and nearby communities at elevated and accelerating risk to coastal hazards. 

2 Methods 

2.1 Geospatial transformation of historical and LiDAR bathymetric soundings 

Our selection of study sites was based on the availability of historic bathymetry that was collocated with recent Light 

Detection and Ranging (LiDAR) elevation data, had sufficient point density and geospatial information to support 15 

meaningful comparisons with LiDAR data, and spanned low to high anthropogenic impact time periods. We defined relative 

anthropogenic impact based on the simplest first-order parameter of population. Low anthropogenic impact (historic data or 

geographic area) was defined as having a population of approximately half or less of recent time periods or uninhabited 

geographic area (Table S3). Population data was acquired from the U.S. Census Bureau (U.S. Census Bureau). Full analysis 

of anthropogenic impact factors (e.g., urban extent, developed land, terrestrial water run-off, water quality, etc.) is beyond 20 

the scope of this paper.  

 

Historical hydrographic survey (H-sheet) data collected by the United States Coast and Geodetic Survey (USC&GS) or the 

National Ocean Service (NOS) between 1934 and 1982, including descriptive reports, digital XYZ sounding data and 

smooth sheets, were downloaded from National Oceanic and Atmospheric Administration’s (NOAA) Office of Coast Survey 25 

(NOAA Office of Coast Survey). The number of H-sheets used for each study site varied from 1 to 24 depending on 

geographic area. All data sources and descriptions are listed in Table S1. The historical sounding data for Buck Island and 

Maui were reported to the nearest tenth of a fathom (18 cm) for water depths less than 20 fathoms (37 m) and 11 fathoms (20 

m), respectively, and to the nearest 1 fathom (1.8 m) for greater water depths. Therefore, we only used data from shallower 

depths than these thresholds at these study sites.  30 

 

Sounding position for 1930’s data was determined by sextant triangulations using both permanent and temporary 
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topographic reference points or triangulation stations, theodolite fixes, navigational beacons, and ship time and speed fixes 

(Shalowitz, 1964). Sounding data that was downloaded from the NOAA website for use in our study had already been 

digitized by personnel at NOAA. Vertical units for the original soundings remained in their original vertical datum, but were 

converted from feet and fathoms to meters by NOAA. We determined vertical datums for the digitized soundings by 

reviewing the smooth sheet notes and descriptive reports. NOAA also converted horizontal datums of the digital XYZ 5 

soundings to North American Datum 1983 (NAD83) during the digitization process. 

 

Comparison between historical and modern sounding data sets required conversion to a common vertical datum. We 

adjusted data using NOAA relative sea level rise (RSLR) estimates to account for any differences at tide stations caused by 

sea level rise, glacial rebound, and subsidence (Parker, 1992; Byrnes et al., 2013) between time periods. Tide stations nearest 10 

to each study site, and with length of sea-level-trend data that spanned the time range of historical and modern bathymetric 

data sets, were chosen for acquisition of mean sea-level-trend data (Table S3). The correction factor was based on NOAA’s 

mean sea-level-trend rate and multiplied by the time span between the year of the historical survey and the year of the 

modern LiDAR dataset and added to the historical sounding value. 

 15 

We transformed historical sounding data from tidal datums mean low water and mean lower low water (MLW/MLLW) to a 

modern orthometric datum using NOAA’s vertical datum transformation software (VDatum v3.6) to adjust vertical and 

horizontal datums to match those of corresponding modern LiDAR data. The XYZ output files were reformatted in Excel to 

remove unnecessary columns and add appropriate headers before importing into ESRI ArcGIS ArcMap 10.2.2 to create 

shapefiles. Review of the smooth sheets revealed soundings from multiple time periods. The metadata associated with the 20 

digital soundings did not include information on which soundings were digitized. We georectified the smooth sheets using 

available North American Datum 1927 (NAD27) corrections on the smooth sheets and additional control points if necessary 

to determine which points were included during NOAA’s digitization process.  Smooth sheets georectified to NAD27 were 

then projected to Universal Transverse Mercator (UTM) NAD83 in ESRI ArcGIS ArcMap 10.2.2. Digital XYZ sounding 

data were overlaid on the smooth sheets and reviewed point by point to determine and remove soundings from the shapefile 25 

(Buster and Morton, 2011) that were from earlier or later time periods. Edited digital XYZ sounding files for each smooth 

sheet were then merged to create a single digital XYZ sounding shapefile for each study area at the time period of interest. 

 

LiDAR data sets (U.S. Army Corps of Engineers-JALBTCX, 1999, 2004; Brock et al., 2006; Brock et al., 2007; Fredericks 

et al., 2015b, a) from the USGS Coastal and Marine Geology LiDAR program and the U.S. Army Corps of Engineers 30 

(USACE) Joint Airborne LiDAR Bathymetry Technical Center of Expertise (JALBTCX) were downloaded for each study 

site (Table S1). LiDAR digital elevation models (DEMs) for Atlantic/Caribbean and Pacific sites were at horizontal spatial 

resolutions of 1 m and 4 m, respectively, with horizontal datums of UTM NAD83, and vertical datums of NAVD88 

GEOID03 for the Atlantic, VIVD09 for the Caribbean, and MLLW for the Pacific.  We imported LiDAR datasets to ArcMap 
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in raster format. We used ArcMap Spatial Analyst Tools (‘Extraction’ > ‘Extract Values to Points’) and the XYZ historical 

point-data shapefiles to extract corresponding elevations from the LiDAR DEMs at the location of the historical points. The 

resulting shapefile from the historical-point to LiDAR-DEM (point-to-DEM) extraction contained fields for historical and 

LiDAR soundings. 

 5 

2.2 Calculation of elevation change 

Elevation change between historical and modern data was calculated by adding a field to the attribute table of the point-to-

DEM shapefile. We then used the ‘Field Calculator’ to calculate the elevation differences between the historical and LiDAR 

soundings and created a new XYZchange data set whereby Zchange = modern LiDAR elevation data point – historical elevation 

data point (negative values indicate loss of seafloor elevation and positive values indicate gain of seafloor elevation). We 10 

used the XYZchange data sets for elevation analysis of each study site including calculation of mean elevation change and 

analysis of elevation change by habitat type. 

2.3 Elevation- and volume-change analysis – TIN modeling 

We used a multi-step process in ArcMap to create a surface model from the XYZchange points to estimate seafloor-elevation 

and reef-volume changes. First, we created a Triangulated Irregular Network (TIN, a digital data structure used in a 15 

geographic information system (GIS) for representing a surface) from the XYZchange points using the ‘Create TIN’ tool. TIN 

surface modeling of historic bathymetry data was used due to the irregular spatial distribution of these XYZchange points.  

However, because the Delaunay triangulation algorithm used by the ‘Create TIN’ tool creates a comprehensive network of 

triangles spanning the entire dataset, some of these triangles were inapplicable to our study.  For example, the XYZchange 

points for Maui form a ring around the island, however, the resultant TIN includes triangles spanning the interior of the 20 

island.  We removed such triangles from each TIN using the ‘Delineate TIN Data Area’ tool by specifying a maximum edge 

length for triangulation determined for each site based on its geographic characteristics and the spacing of the XYZchange 

points.  The lengths we used were 200 m for Buck Island (BI); 400 m for the Upper Florida Keys (UFK) and St. Thomas 

(STT); 900 m for the Lower Florida Keys (LFK); and 1000 m for Maui. Next, we created a polygon representing the 2-

dimensional footprint of the TIN using the ‘TIN Domain’ tool.  After this clipping process, smaller triangles that covered 25 

sub-aerial features (such as rock outcroppings, sand spits, and small islands) still remained in some data sets.  Since the 

LiDAR DEMs we used contained only bathymetric surfaces, such features were not included, and we used the 2D LiDAR 

footprint to remove these triangles according to the following steps. We created a polygon representing the 2-dimensional 

footprint of the DEM using the ‘Raster Domain’ tool.  Next, we created a new polygon representing the intersection of the 

TIN and LiDAR footprints using the ‘Clip’ tool.  We set the ‘Input Features’ parameter to the TIN footprint and the ‘Clip 30 

Features’ parameter to the LiDAR footprint.  These parameter settings were critical for obtaining the correct result.  Finally, 

we used the footprint-intersection polygon to remove any remaining irrelevant triangles from the TIN by applying the ‘Edit 
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TIN’ tool and the following parameter settings:  

1) set ‘Input Feature Class’ to the footprint-intersection polygon;  

2) set ‘Height Field’ to ‘None’;  

3) set ‘SF Type’ to ‘Hard Clip’; 

4) set ‘Tag Field’ to ‘None’.   5 

The resultant clipped TINs encompassed all XYZchange points and were free of extraneous triangles. We used these clipped 

TINs to compute surface volumes using the ‘Surface Volume’ tool for 4 scenarios based on the following parameter settings: 

1) net accretion – maximum bound: ‘Reference Plane’ set to ‘ABOVE’ and ‘Plane Height’ set to 0 m 

2) net erosion – maximum bound: ‘Reference Plane’ set to ‘BELOW’ and ‘Plane Height’ set to 0 m 

3) net accretion – minimum bound: ‘Reference Plane’ set to ‘ABOVE’ and ‘Plane Height’ set to 0.5 m 10 

4) net erosion – minimum bound: ‘Reference Plane’ set to ‘BELOW’ and ‘Plane Height’ set to -0.5 m 

The two ‘minimum bound’ cases are estimates that account for combined measurement errors (discussed in the ‘Vertical 

error analysis’ section) in both the historical sounding and LiDAR elevation data. We also used the ‘Surface Volume’ tool to 

compute the 2-dimensional footprint area of each clipped TIN by setting  ‘Reference Plane’ to ‘BELOW’ and ‘Plane Height’ 

to a positive value greater than the highest TIN elevation.  In our study, we used a plane height of 100 m to force the 15 

algorithm to take a nadir view of the TIN. 

2.3.1 Elevation- and volume-change analysis by habitat 

We obtained benthic-habitat-map shapefiles (Florida Fish and Wildlife Conservation Commission, 2015) for the Upper and 

Lower Florida Keys study sites from Florida Fish and Wildlife Conservation Commission (FWC). The Unified Florida Reef 

Tract (UFRT) map Version 1.2 is comprised of 5 class levels from 0 to 4. We used class level 2 for our study because the 20 

level of detail was consistent with benthic habitat data available at our other study sites.  We obtained benthic-habitat-map 

shapefiles for the USVI and Maui from NOAA (Rohmann, 2001b, a; Battista and Christensen, 2007).  We delineated USVI 

habitats using the ‘type’ descriptor in the shapefile’s attribute table. We delineated Maui benthic habitats using the 

‘D_STRUCT’ class in the attribute table. We retitled the habitat class named ‘Rock/boulder’ in the ‘D_STRUCT’ class that 

corresponded to the descriptor from the ‘M_STRUCT’ class named ‘Coral Reef and Hard Bottom’ to clarify that particular 25 

substrate type is a coral-dominated habitat. All classes were chosen to provide a common level of benthic habitat detail 

across study sites. Once the habitat classes were chosen, we exported them as individual shapefiles with ArcMap. 

 

We determined elevation change by habitat using the XYZchange data points. We computed elevation-change statistics from 

the points included within or on the boundary of each habitat. For a given site, we opened the corresponding XYZchange 30 
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shapefile and the polygons defining the boundaries of a given habitat class in ArcMap and applied the ‘Select Layer By 

Location’ tool to extract the points falling within or on the boundaries of the habitat.  Parameter settings were:  

1) set ‘Input Feature Layer’ to the layer containing the XYZ points;  

2) set ‘Relationship’ to INTERSECT;  

3) set ‘Selecting Features’ to the layer containing the habitat polygons;  5 

4) leave ‘Search Distance’ blank; and  

5) set ‘Selection type’ to NEW_SELECTION.   

We also created an ArcMap ‘model’ to automate the XYZchange data-point processing for calculation of elevation-change 

statistics in Table 2, and to ensure consistency for each habitat class. The elevation gain and loss statistics are based on the 

set of points with elevation changes greater than or less than zero, respectively. 10 

 

We computed volume changes in accretion and erosion per habitat class using a procedure similar to the one used to 

compute site-wide changes (see ‘Elevation- and volume-change analysis-TIN modeling’ section).  For a given site and 

habitat class, we created a new polygon from the intersection of the site-footprint with a habitat-class polygon using the 

‘Clip’ tool.  This habitat-extraction polygon was necessary because habitat coverage extended beyond the bounds of each 15 

site TIN.  With this refined habitat polygon, we applied the ‘Edit TIN’ tool to the site TIN, creating a new TIN covering only 

the extent of the specified habitat class.  Finally, we performed the same set of surface volume calculations as described in 

the TIN modeling section.  Because these steps had to be repeated for each habitat class for each study site, we created an 

ArcMap ‘model’ to automate the process and for calculation of volume-change statistics (Table 3). We determined the 

amount of elevation and volume change in coral-dominated habitats and adjacent (non-coral dominated) habitats by 20 

grouping the elevation and volume change results for the pertinent habitat classes (Tables 2 and 3) and computing combined 

values for ‘coral substrate’ and ‘adjacent substrate’ at each site (Table 1). 

2.4 Lower Florida Keys – volume to Pleistocene bedrock 

The depth-to-Pleistocene-bedrock (DPB) surface was constructed from seismic data and cores along the Florida Keys reef 

tract from southern Key Largo through the Dry Tortugas, and was obtained as a shapefile referenced to NAD27 datum at 25 

http://pubs.usgs.gov/pp/2007/1751/data/PP1751.zip (Lidz, 2000;Lidz et al., 2007). The difference between a bathymetric 

surface and DPB surface estimates sediment thickness of the Holocene reef deposit along the Florida Keys reef tract. We 

clipped the extent of the DPB polygons that corresponded to the extent of the LFK study site using the 2D surface area 

polygon for the study site and ArcMap ‘Analysis tools’ > ‘Extract’ > ‘Clip’. Next, we assigned XYZ coordinates to each 

depth-contour polygon with the assigned Z value equaling the corresponding depth contour using Xtools > ‘Table 30 

Operations’ > ‘Add XYZ Coordinates’. We then exported the resulting attribute table as an XYZ-point file to MS Excel 
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using Xtools > ‘Table Operations’ > ‘Export Table’ to MS Excel’. We imported a tab-delimited file format of this XYZ-

point file to VDatum, and assigned NAD27 (the published datum) and MLW to the source file, and UTM NAD83 and 

NAVD88 GEOID03 as the target datums. We reformatted the point file headers in Excel for import to ArcCatalog, created a 

shapefile, and projected the DPB polygons from NAD27 to UTM NAD83 using ‘Data Management Tools’ > ‘Projections 

and Transformations’ > ‘Project’. We then merged the point file with the DPB polygons using ‘Analysis Tools' > ‘Overlay’ 5 

> ‘Spatial Join’ in ArcMap to assign the NAVD88 GEOID03 values from the point file to the polygons. DPB polygons were 

converted to raster format using ‘Conversion Tools’ > ‘To Raster’ > ‘Polygon to Raster’ tool.  

 

We created a raster DEM for historical bathymetric data for calculation of Holocene reef volume in 1938 using the same 

Delaunay triangulation algorithm as described in the ‘Elevation- and volume-change analysis-TIN Modeling’ section with a 10 

maximum edge length for triangulation of 900 m and maximum triangle area of 50,000 m. We calculated historical sediment 

thickness above the Pleistocene bedrock layer using the LFK 1938 DEM by subtracting the DEM surface from the updated 

DPB layer using ‘Spatial Analyst Tools’ > ‘Map Algebra’ > ‘Raster Calculator’ to create a raster that represented sediment 

thickness. We compared total Holocene reef volume to recent net volume loss (Table 1) considering that net volume and 

mass changes from 1938 to 2004 would have converged if reef framework had filled with sediment and accreted rather than 15 

eroded.  To compute the time required to completely erode the remaining Holocene reef down to the Pleistocene layer, we 

used a modern reef age of 6000 years (Lidz, 2000) and a constant erosion rate.  

2.5 Error analysis 

2.5.1 Vertical error analysis 

U.S. Federal Standards were applied for all vertical and horizontal data transformations and error analyses. To provide 20 

conservative estimates of elevation changes, we followed the general approach used by the U.S. Army Corps of Engineers 

(Byrnes et al., 2002) to compute a composite root-mean-square error (RMSE) for our data (Table 4), according to Eq. (1). 

 

𝑅𝑀𝑆𝐸!"#$% = 𝑅𝑀𝑆𝐸!"#$%&$'! + 𝑅𝑀𝑆𝐸!"#$%! + 𝑅𝑀𝑆𝐸!"#$%&!          (1) 

  25 

where RMSESounding was computed from the historical point data, and RMSELiDAR was reported in the metadata accompanying 

the LiDAR data for each site and based on independent validation by in-water acoustic-based depth measurements. Error 

associated with vertical datum transformation, RMSEVDatum, was computed using VDatum version 3.6 (NOAA National 

Ocean Service, 2016). Note that no vertical transformations were performed for the Maui data because both historical and 

modern bathymetric data were collected and reported relative to MLLW; therefore, RMSEVDatum was excluded from vertical 30 

error estimates for this study site. The maximum cumulative uncertainty (MCU) for operational VDatum regions of South 

Florida and the Virgin Islands are 9.6 cm and 11.8 cm, respectively (NOAA National Ocean Service, 2016). Our calculated 
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RMSEVDatum for the Florida Keys, St. Thomas and Buck Island study sites fall within reported MCU values (Table 4).  

 

When historical sounding data were collected, repeat surveys were performed along select transect lines and/or additional 

soundings were collected along intersecting transects for the purpose of determining vertical accuracy. Only maximum 

difference of repeat data points was reported as accuracy information in the historical data set descriptive reports. For data 5 

collected by the Coast Survey from the late 1800’s to 1950’s, maximum allowable differences at crossings were 0.06 m for 

depths less than 4.6 m, and 0.46 m for depths between 22 and 29 m (Byrnes et al., 2002). For data collected from the mid to 

late 1900’s, when positioning and water depth measurements advanced from manual to electronic, maximum allowable 

water depths at offshore crossings were not to exceed 0.6 m (Byrnes et al., 2002). We used these repeat and cross-track line 

survey data to perform a more rigorous systematic error analysis of historical depth measurements (Byrnes et al., 2002). For 10 

each historical sounding point we computed the distance between it and all the remaining points within a given study site.  

We retained only those point pairings that were separated by ≤5 m.  Given that rapid elevation changes over short distances 

occur in coral reef environments, we further filtered the pairs, keeping those with an absolute depth difference of ≤ 0.5 m, 

i.e., , where di,1 and di,2 are the depths of the two points in the i-th pair.  Applying this threshold avoids 

sharp drop-offs, such as channel edges and situations were one point is on the reef and the adjacent point is in a depression or 15 

off the reef.  We set the threshold at 0.5 m because it was greater than both the measurement resolution for any data set and 

the largest measurement difference between reported replicate values for those data sets that reported replicates. With the 

remaining paired points, we computed RMSESounding according to Eq. (2) for n point pairings. 

 

  (2) 20 

 

The number of sounding points pairs used for each location was 40, 253, 40, and 51 for the UFK, STT, STC and Maui, 

respectively. The LFK was excluded from this analysis because no adjacent points were separated by 5 m or less. Implicit in 

this approach is the assumption that the points in each pairing represent two independent depth measurements at 

approximately the same location.  Therefore, the mean difference in depth between all pairs should not be significantly 25 

different from 0 m.  For each study site, we performed a 2-tailed t-test at the α = 0.05 level on the set of depth differences 

between paired points to test the null hypothesis of a zero mean difference.  All of the RMSE calculations and t-tests were 

performed using Matlab v8.4.0 (R2014b), and are reported in Table 4. 

 

Using the individual RMSETotal values, we computed a single, more conservative RMSE value that was applied to all five 30 

study sites.  We considered the RMSETotal values from each study site to be proxies for the standard deviations ( ).  In a 

di,1 − di,2 ≤ 0.5

RMSESounding =
di,1 − di,2( )2

i=1

n

∑
n

σ
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normal distribution, 1-  encompasses approximately 68% of the variability and 2-  encompasses approximately 95%.  

We chose to multiply the RMSETotal values by 1.65, capturing approximately 90% of the variability in the depth differences.  

The average of these new values was 0.48 m, which we rounded to 0.5 m and applied as a global RMSE applicable to all of 

our study sites to compute the minimum bound of the volume change estimates. Our average RMSETotal (0.29 m) is similar to 

that reported for lidar and acoustic sounding data and half the reported value for previous studies that used nautical chart data 5 

to create a digital elevation model for examining the response of a reef to sea level rise (Leon, 2013b;Hamylton, 2014). 

2.5.2 Horizontal error analysis 

All horizontal datums of the historical XYZ data were converted to North American Datum 1983 (NAD83) by NOAA 

during the digitization of historical smooth sheets. No horizontal error was reported for any historical data sets. Our 

historical sounding data ranged from the 1930’s to 1980’s. Visual inspections of georectified historical H-sheets overlain on 10 

modern georectified aerial imagery of 1 m resolution showed good alignment between coastal and geographic features (2016 

World Imagery from ArcGIS online via ArcMap 10.2.2, source: Esri, DigitalGlobe, GeoEye, Earthstar Geographics, 

CNES/Airbus DS, USDA, USGS, AEX, Getmapping, Aerogrid, IGN, IGP, swisstopo, and the GIS User Community). We 

determined the potential horizontal error associated with our oldest data sets from the 1930’s (Florida Keys), measured using 

triangulation methods, and used this as an estimate of maximum horizontal error for all study sites.  15 

 

The original horizontal datum for data sets from the Florida Keys was North American Datum 1927 (NAD27). Conversion 

of data from NAD27 to NAD83 using NOAA National Ocean Service program NADCON introduces no more that 15 cm of 

uncertainty in the continental United States (Dewhurst, 1990). The Annual Report of the U.S. Coast and Geodetic Survey 

192 (1880) indicates that it was possible under normal controls to measure distances (using triangulation) with an accuracy 20 

of 1 meter, and the position of the plane table could be determined within 2 to 3 meters of its true position (Shalowitz, 1964). 

The horizontal resolution of LiDAR data is reported as better than 1m (Brock et al., 2006; Brock et al., 2007; Fredericks et 

al., 2015a, b). A sum of estimated sources of error is, therefore, approximately 5 m (maximum uncertainty from NADCON 

conversion + accuracy of triangulated distance measurements + accuracy of plane table position + horizontal resolution of 

LiDAR data). During visual inspection of H-sheets, we measured, for example, a maximum difference of 4.8 m between the 25 

position of a historical bridge structure located south of Lower Matecumbe Key in the UFK as depicted on a 1934 H-sheet 

and on the 2016 World Imagery. This offset is consistent with the sum of estimated horizontal uncertainties that include 

historical position measurements using triangulation.  

 

We minimized horizontal uncertainties due to data density and track line orientation by extracting modern data points from 30 

high-resolution LiDAR DEMs (1 to 4 m) at the location of the more coarsely distributed historical data points. We created a 

single TIN model from the calculated elevation differences (Zchange) between these points for volume change analyses, rather 

σ σ
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than determining volume change by comparing separate historical and modern TIN models. We performed a horizontal shift 

analysis to test the potential impact for systematic plus random horizontal error of up to 10 m. We chose 10 m as a 

conservative value because it represents an approximate doubling of the sum of estimated sources of error (5.0 m), as well as 

a doubling of the maximum observed offset of a fixed structure in our data set (4.8 x 2 = 9.6 m). Historical XYZ elevation 

data from the Upper and Lower Florida Keys were shifted by 10 meters to the north, south, east and west by adding 10 m to, 5 

and subtracting 10 m from, UTM northings and eastings for each data point (26,341 and 1,688 points for the Upper and 

Lower Florida Keys, respectively). This exercise generated 4 new, experimental historical XYZ point-data sets that simulate 

up to 10 meters of horizontal error in each of 4 directions. We used these experimental data sets to create new shapefiles for 

each study site. Un-shifted LiDAR DEMs were clipped to each shifted historical shapefile, then corresponding elevations 

from the LiDAR DEMs were extracted at each historical point location and used to calculate elevation differences between 10 

the shifted historical soundings and un-shifted LiDAR data sets as previously described. We created new TIN models from 

the shifted XYZ point-data sets and calculated volume changes for each of these data sets using the TIN modeling process 

and surface volume analysis previously described (this study). 

 

Results from the horizontal shift analysis indicate that 10 m of horizontal error produces no more than 10% difference in net 15 

and area-normalized volume change calculations in the Upper Florida Keys, and up to a 21% difference in the Lower Florida 

Keys (likely due to a lower density of data points over a smaller geographic area). Imparting 10 m of error in these 

experimental data sets does not change the general conclusion of our study indicating high magnitude of net erosion at these 

study sites. Our results are consistent with reports that over large areas (such as in our study), random errors largely cancel-

out relative to change calculations derived from two surfaces (Byrnes et al., 2002). 20 

3 Results 

3.1 Regional-scale loss of mean seafloor elevation and volume 

Loss of seafloor elevation and volume, and transition from net accretion to net erosion, has occurred at all study sites (Table 

1). Mean seafloor elevation losses ranged from -0.09 m to -0.8 m across all of these regions. These regional mean values 

(‘Mean elevation-change’ column in Table 1) represent the net change encompassing all positive (elevation-gains) and 25 

negative (elevation-losses) values. Large ranges of elevation change were observed within each study site with maximum 

losses exceeding 4.0 m and maximum gains exceeding 6.5 m resulting in high standard deviations of 0.7 m to 1.5 m for all 

sites (Table 2).  

 

Examination of only those locations within habitats where elevation-losses occurred (‘Mean loss’ column in Table 2) 30 

indicates that, of the 59 individual habitat analyses we performed across all five study sites, only two habitats showed mean 

losses less than our RMSETotal of 0.29. Only 14 habitats showed mean losses less than our 1.65 x RMSETotal of 0. 5 m (that 
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encompasses 90% of the variability). Therefore, mean losses in 97% of the habitats we analyzed were greater than our 

vertical RMSETotal of 0.29 m, and 77% of the habitats we analyzed showed mean losses greater than 1.65 x RMSETotal of 0.5 

m. In several cases, and particularly associated with coral-dominated substrate, mean losses exceeded 1 meter (‘Mean loss’ 

column in Table 2). Conversely, examination of only those locations within habitats where elevation gains occurred (‘Mean 

gain’ column in Table 2) indicates that 92% of the 59 habitats showed mean elevation-gains greater than our RMSETotal, and 5 

60% showed mean gains greater than our 1.65 x RMSETotal. 

 

Net volume losses were also observed in all regions indicating export of sediments from these systems (Table 1). Minimum 

volume changes (calculated by excluding elevation change data within a vertical range of ±0.5 m, see 1.65 x RMSE 

calculations in Table 4) provide conservative estimates of net volume losses ranging from 0.2 to 52.8 million cubic meters 10 

(Mm3). Maximum volume changes (including all elevation-change data) indicate net volume losses ranging from 3.4 to 80.5 

Mm3 for all study sites. We did not convert volume to mass of calcium carbonate because volume change includes sediment 

compaction, loss due to mortality and degradation of framework-building coral colonies, and sediments of various porosities. 

3.2 Changes in mean seafloor elevation and volume by habitat type 

Mean elevation and volume losses occurred in 78% of the 59 individual habitats that we examined (Table 2). Greatest mean 15 

elevation losses were generally associated with shallow, coral-dominated habitats (Table 1 and Table 2) at all study sites 

consistent with observations of general flattening (Alvarez-Filip et al., 2009) of reef topography and observations of 

decreasing abundance of reef-building corals (Gardner et al., 2003; Bruno and Selig, 2007; 2014). However, greatest net 

volume losses were generally associated with adjacent (non-coral dominated) habitats despite smaller mean elevation losses 

due to their greater areal extent (Table 1 and Table 3). Maximum values of area-normalized volume change calculated using 20 

all elevation change data (Table 1) indicate that volume loss in adjacent habitats was 40% to 100% of losses observed in 

coral-dominated substrate. Areal extent of coral-dominated substrate was only 8% to 15% of the total study area in the Upper 

and Lower Florida Keys and St. Thomas, and contributes up to only 26% of the total net volume loss. Areal extent of coral-

dominated substrate was much higher at the Maui study site, 57%, and contributed more than 50% to net volume loss. The 

considerable loss of seafloor volume in adjacent habitats at these study sites and large total net volume losses suggests that 25 

physical erosion of adjacent habitats and export of sediments is a likely driver of much of the volume loss we observed at 

these study sites rather than degradation of high porosity, large framework-building corals and redistribution of sediments 

within the system. Buck Island showed the lowest net volume and mean elevation loss, and the highest areal extent of coral-

dominated substrate (91%) that contributed more than 90% to net volume loss, suggesting that degradation of framework-

building corals may be the primary contributor to volume loss at this study site and much less sediment has been exported. 30 

 

Along the Florida Keys reef tract within Biscayne National Park, Florida and the Florida Keys National Marine Sanctuary, 

mean elevation and volume losses occurred in 9 of 11 habitat classes in the Upper Florida Keys (UFK) reef tract (Fig. 1a, b) 
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and in 6 of 9 classes in the Lower Florida Keys (LFK) reef tract (Fig. 1c, d) including coral habitats, and adjacent habitats 

such as unconsolidated sediments, pavement previously covered by sediments or coral, and seagrass. Largest mean elevation 

losses occurred at shallow patch and aggregate reefs, coral-dominated and reef rubble habitats, consistent with documented 

declines in abundance of large framework-building corals over the past several decades (2014). Largest net volume losses 

occurred in seagrass and unconsolidated sediment habitats. Mean elevation and volume gains occurred in deep water habitats 5 

including offshore aggregate reefs in the LFK near a sanctuary preserve area, at the base of spur-and-groove habitat along 

fore-reef slopes, and where relic spur-and-groove formations in-filled with sediments indicating transport of reef sediments 

down the fore-reef slope and export offshore. Mean total elevation loss was lowest at the UFK study site. However, mean 

elevation losses decreased from upper (-0.4 m) to central (-0.3 m) sub-regions of the UFK, and mean elevation increased 

slightly in the lower sub-region (0.1 m) primarily associated with seagrass habitat (Fig. 1a, b). Notably, the lower sub-region 10 

is further away from high-density population areas north of the study site and near an area of the middle Florida Keys 

identified as a possible refuge from ocean acidification due to seagrass productivity (Manzello et al., 2012). The LFK site 

included the Looe Key National Marine Sanctuary and Special Protection Area (Fig. 1c). Net elevation and volume losses 

were similar to the central sub-region of the UFK possibly due to close proximity to high-density population areas in the 

Lower Florida Keys. However, the LFK was the only study site that showed net accretion in combined coral habitat classes. 15 

Accretion is partially attributed to deep reef and spur-and-groove habitat that has been buried by sand (Lidz et al., 2007). 

Redistribution of reef materials and erosion of the Florida reef tract is corroborated by field observations of movement and 

deposition of meters-thick sand deposits likely due to hurricanes and by exposure of older reef material from erosion and 

transport (Shinn et al., 2003). However, accretion was also observed on offshore aggregate reef habitat near the Special 

Protection Area.  20 

 

Mean elevation and volume loss occurred in 16 of 17 habitat classes in St. Thomas, USVI (STT, Fig. 2a, b). However, 

uninhabited Buck Island National Reef Monument and Marine Park, St. Croix USVI (BI) showed less mean elevation and 

volume loss than all other sites with losses limited to 4 of 11 habitat classes including 3 coral habitats (Fig. 2c, d). In STT, 

small, localized areas of coral-dominated substrate showed gains in elevation. However, greatest mean elevation losses 25 

occurred in coral-dominated habitats and near the central coastline where harbor and shipping channels exist.  Mean 

elevation and volume gains only occurred on un-colonized bedrock possibly due to transport and deposition of sediments. 

The study period for BI is approximately 10 years shorter than for nearby STT. Greatest mean elevation gains in BI occurred 

along linear reef near the shoreline. Most elevation and volume gains occurred within Buck Island National Reef Monument 

and Marine Park boundaries (Fig. 2c) suggesting that distance from populated areas combined with managed protection has 30 

limited losses at this site.  

 

Mean elevation and volume loss occurred in 10 of 12 classes in Maui (Fig. 3a, b). Mean elevation and area-normalized 

volume losses were at least 2 to 3 times greater, respectively, than all other study sites and occurred over a shorter time-
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frame. These greater losses may be caused by higher sediment export rates due to a combination of higher wave energy, 

physical erosion and a narrow shallow shelf surrounding the island allowing sediment to be more easily transported offshore 

into deep water, as has been observed in other high energy reef environments (Morgan, 2014; Perry, 2015). Greatest mean 

elevation losses were associated with coral-dominated habitat as well as ‘not classified’ habitat located in the bank/shelf 

zone that may be impacted by slumping of materials along steeply sloping areas. Elevation and volume gains occurred in 5 

mud and rubble habitats, and may be associated with terrigenous sediment transport from the island. 

4 Discussion 

Our results include elevation and volume changes caused by chronic erosion processes that occur slowly over time frames of 

months to decades such as changes in carbonate production rates, bioerosion, chemical erosion from carbonate dissolution, 

degradation of large framework building coral colonies, and physical movement of reef sediments due to persistent 10 

oceanographic conditions such as waves and currents. Our results also include changes caused by episodic events that occur 

over very short time frames of minutes to days, and often cause large changes in elevation. Examples include dredging and 

infilling of channels and coastal harbors, deposition of terrigenous materials from landslides and run-off, slumping and 

relocation of seafloor materials at steeply sloping locations, storm erosion and deposits. We included large elevation-change 

data in our calculations likely caused from these episodic events because such changes affect process modeling for hazards 15 

analysis and alter habitat distribution. We note that much reef degradation contributing to elevation change likely occurred 

after 1970 (Gardner et al., 2003; Bruno and Selig, 2007; 2014). Therefore, data sets containing pre-1970’s data (Table S1) 

could be biased toward lower annual elevation and volume-change rates. 

 

Over 90% of the habitats we analyzed in our study showed statistically significant elevation-changes with a net result of 20 

elevation loss. Erosion of both coral-dominated substrate and non-coral substrate suggests that the current rate of carbonate 

production is no longer sufficient to support net accretion of coral reefs or adjacent habitats. Our results indicate that mean 

seafloor elevation decreased by -1.5 to -6.3 mm yr-1 over 33 to 68 years at Atlantic and Caribbean sites, and by -21.1 mm yr-1 

over 38 years at the Pacific site (Fig. 4). These elevation changes are equivalent to loss of 34 to 115 years of reef accretion 

based on average Holocene reef accretion rates of 2.6 and 10 mm yr-1 for Caribbean/Atlantic and Pacific reefs, respectively 25 

(Shinn et al., 1977; Buddemeier and Smith, 1988). Coral reefs in all three regions have lost pace with historical global mean 

sea level rise of 1.7 mm yr-1 between 1901 and 2010, and will be unable to keep up or catch up with current or projected 

rates of 3.2 mm yr-1 (1993-2012) and 4.5 mm yr-1 (mid-century, RCP4.5), respectively (Church et al., 2013).  

 

The seafloor elevation and volume losses observed in our study indicate the extent of erosion that has already occurred in 30 

many coral reef ecosystems may be largely under-estimated without comprehensive analysis of total elevation and volume 

change. Without such analyses, assessments of risk levels and impact from coastal hazards due to coral reef degradation may 
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also be under-estimated. Recent estimates of modern reef accretion and erosion rates on Caribbean reefs based on only 

carbonate production and bioerosion indicate average potential accretion of 1.36 mm yr-1 and range from -1.17 to 11.93 mm 

yr-1 (Perry et al., 2013). Assuming a maximum erosion rate of -1.17 mm yr-1 (Perry et al., 2013), reduced carbonate 

production and bioerosion could account for as much as 65% of the erosion we observed at Buck Island (-1.8 mm yr-1), but 

only 19% of erosion observed at St. Thomas (-6.3 mm yr-1). Recent regional-scale measurements of carbonate production 5 

and dissolution in the Florida Reef Tract show that dissolution alone could account for chemical erosion of up to 

approximately -0.7 mm yr-1 in the northernmost reef tract (Muehllehner, 2016), or approximately 12% of the erosion we 

observed in the upper region of the Upper Florida Keys (-0.4 m total or -5.9 mm yr-1). Combining maximum estimates for 

reduced carbonate production, bioerosion and chemical dissolution could account for much of the elevation loss at BI, but 

only approximately 30% of erosion at STT and the UFK. Our results indicate that as much as 35 to 88% of erosion in these 10 

regions may be attributed to physical processes and/or export of reef sediments from these systems that has been 

unaccounted for in previous assessments of seafloor accretion and erosion rates in modern coral reef ecosystems.  These 

values are similar to sediment export estimates ranging from 20% to greater than 50% on a Maldivian reef platform along 

sheltered and exposed reef margins, respectively (Morgan, 2014; Perry, 2015).  

 15 

The magnitude of regional-scale erosion, millions of cubic meters, from these reef systems (Table 1) following world-wide 

declines and transitions in reef species composition combined with projections for continued global reef degradation 

suggests the onset in the geologic record of an Anthropocene reef crisis (Kiessling and Simpson, 2011). For example, we 

calculated that Holocene reef volume at the LFK site was 101.2 Mm3 in 1938 by performing a difference analysis between 

the 1938 historical DEM (this study) and a georectified map of depth-to-Pleistocene bedrock (Lidz, 2000). Comparison of 20 

total Holocene reef volume in 1938 to net volume loss from 1938 to 2004 (Table 1) indicates that Holocene reef volume has 

decreased by as much as 5% over the past 66 years and that the reef is eroding 5 times faster than it accreted throughout the 

Holocene. Assuming a modern reef age of 6000 years (Lidz, 2000)  and a constant erosion rate, total reef volume at this 

location could completely erode down to Pleistocene-bedrock-surface in approximately 1250 years.  

 25 

Previous studies indicate that, in some cases, higher sea level will facilitate production and transport of unconsolidated 

sediments shoreward, and growth of reef islands (Hopley, 1988; Hopley, 1992). However, our results indicate net export of 

sediments from the regions in our study as well as evidence for offshore transport of materials. Studies of ancient reefs 

indicate that many were able to keep up or catch up with sea level rise (Neumann A.C., 1985). However, ancient reefs that 

were exposed to local, regional and global environmental stresses were unable to keep up and drowned (Schlager, 1981; 30 

Hubbard, 1997; Kiessling and Simpson, 2011). Recent projections of reef response to sea level rise in the northern Great 

Barrier Reef using carbonate production rates primarily from the 1970’s indicate that shallower reef flats could become 

colonized by corals with a rise in sea level of 0.5 m, but begin to drown after 30 years with a rise of 1.2 m (Hamylton, 2014). 

However, these projections do not consider reduced rates of calcification due to local and global stressors and loss of 
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carbonates from erosion processes. Chagos Archipelago reef systems in the Indian Ocean that are both geographically 

isolated and lack human impacts show high accretion rates and the ability to recover from bleaching events (Perry, 2015). 

However, the large erosion rates we observed in Maui suggest that heavily populated islands may not recover despite 

geographic isolation. We observed lower erosion rates in reef ecosystems that were managed, distant from human population 

centers, or associated with natural refuge zones; however, these lower rates did not prevent net regional-scale losses of 5 

seafloor elevation and volume. Modern carbonate production rates are an order of magnitude lower than Holocene averages 

(Perry et al., 2013), and are estimated to decrease by as much as 60% by mid-century (Langdon and Atkinson, 2005). 

Bioerosion and chemical dissolution of carbonates will increase with ocean acidification (Hoegh-Guldberg et al., 2007; Eyre 

et al., 2014; Enochs, 2015). Therefore, reef erosion rates are likely to accelerate over the coming decades. 

 10 

Numerical models indicate that loss of reef structure and seafloor elevation increases coastal vulnerability to erosion, storm 

surge, waves, sea level rise and tsunami hazards that are predicted to intensify and become more frequent with global climate 

change (Lowe et al., 2005; Quataert et al., 2015). An increase in water depth of 0.5 to 1.0 m from rising sea level by 2100 is 

projected to cause larger waves and accelerated physical erosion of sediments on fringing reef flats and adjacent coastlines 

(Storlazzi et al., 2011). Our results show that degradation of coral reef ecosystems in Atlantic, Caribbean and Pacific regions 15 

has accelerated the relative increase in water depth from sea level rise, and has already increased water depths to levels that 

were not expected until near 2100. We projected increases in water depth at our study sites based on our measured rates of 

mean elevation loss combined with sea level rise. Our projections indicate that seafloor erosion will increase water depths by 

2 to 8 times more than levels predicted from sea level rise alone by the year 2100 at all study sites (Fig. 5, Table S9). The 

divergence between rising sea level and declining seafloor elevation has already increased the risk to coastlines in these 20 

regions from long-term, persistent oceanographic pressures and periodic events such as storms. The combination of human 

impacts to reefs and unprecedented rates of global climate change are likely to intensify coastal hazard vulnerabilities caused 

by seafloor erosion in coral reef ecosystems over the next century. 
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Table 1. Seafloor elevation and volume change for Atlantic, Pacific and Caribbean study sites. Minimum (Min.) and 

maximum (Max.) volumes are based on vertical error analysis (Table 4). Parenthetical numbers indicate number of 5 

combined habitat classes for each location (Tables 2 and 3). Mm3 = millions of cubic meters. 

Location, time period Study 
area 
(km2) 

Mean 
elevation 
change 
(m) 

Standard 
deviation 
(m) 

Gross erosion 
(Mm3) 

Gross accretion 
(Mm3) 

Net volume 
change 
(Mm3) 

Area- normalized 
volume change 
(Mm3/km2) 

    Min. Max. Min. Max. Min. Max. Min. Max. 

UFK, 1934/35-2002 241.1 -0.1 0.8 -22.2 -69.9 7.5 32.1 -14.6 -37.9 -0.06 -0.2 

LFK, 1938-2004 19.0 -0.3 0.8 -1.8 -8.2 1.6 2.6 -0.2 -5.7 -0.01 -0.3 

STT, 1966/73-2014 116.9 -0.3 0.9 -7.4 -29.1 1.4 7.5 -6.0 -21.6 -0.05 -0.2 

BI, 1981/82-2014 51.8 -0.09 0.7 -2.3 -9.6 0.7 6.1 -1.6 -3.4 -0.03 -0.07 

Maui, 1961/65-1999 84.5 -0.8 1.5 -56.6 -88.5 3.2 7.2 -52.8 -80.5 -0.6 -0.9 

UFK coral habitats (5) 36.1 -0.2 1.1 -5.9 -14.3 2.3 6.3 -3.5 -7.9 -0.1 -0.2 

UFK adjacent habitats 204.9 -0.1 -0.7 -15.6 -54.9 4.8 25.0 -10.8 -30 -0.05 -0.15 

LFK coral habitats (4) 1.6 0.2 1.4 -0.1 -0.4 0.9 1.3 0.8 0.9 0.50 0.55 

LFK adjacent habitats 17.3 -0.4 0.6 -1.6 -7.8 0.7 1.3 -1.0 -6.5 -0.06 -0.40 

STT coral habitats (9) 14.3 -0.5 1.3 -4.0 -7.9 0.6 1.7 -3.4 -6.2 -0.2 -0.4 

STT adjacent habitats 102.7 -0.2 0.6 -3.3 -21.2 0.7 5.8 -2.6 -15.4 -0.03 -0.2 

BI coral habitats (7) 47.1 -0.09 0.72 -2.0 -8.7 0.6 5.6 -1.4 -3.1 -0.03 -0.07 

BI adjacent habitats 4.7 -0.09 0.68 -0.3 -0.9 0.1 0.6 -0.2 -0.3 -0.05 -0.07 

Maui coral habitats (7) 48.4 -0.9 1.5 -32.2 -50.0 1.9 4.2 -30.4 -45.8 -0.6 -0.9 

Maui adjacent habitats 36.2 -0.8 1.5 -23.5 -37.3 1.1 2.6 -22.4 -34.7 -0.6 -1.0 
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Table 2. Elevation change by habitat type. 
Location Area 

(km2) 
Total 
points 
(#) 

Mean 
elevation 
change 
(m) 

Stdev 
(m) 

Max 
loss 
(m) 

Max 
gain 
(m) 

Elevation 
loss 
points 
(#) 

Mean 
loss 
(m) 

Stdev 
(m) 

Elevation 
gain 
points 
(#) 

Mean 
gain 
(m) 

Stdev 
(m) 

Upper Florida Keys 
Total study site 241.1 26341 -0.1 0.8 -8.3 6.5 14996 -0.6 0.7 11345 0.44 0.51 
*Scattered coral/rock in uncons. sed. 0.2 17 -0.8 0.9 -2.0 1.2 13 -1.1 0.6 4 0.5 0.4 
Pavement 17.0 1901 -0.2 1.0 -6.2 4.9 1218 -0.7 0.7 683 0.7 0.7 
*Aggregate reef 11.8 1435 -0.2 1.1 -5.1 4.7 857 -0.8 0.8 578 0.7 0.7 
*Reef rubble 1.5 291 -0.2 0.8 -2.6 3.2 196 -0.6 0.5 95 0.6 0.7 
Unconsolidated sediments 65.3 5498 -0.2 0.6 -6.8 3.4 3526 -0.5 0.5 1972 0.3 0.3 
*Individual or aggregate patch reef 17.2 2078 -0.2 1.1 -6.6 5.2 1170 -0.8 0.9 908 0.6 0.7 
Seagrass continuous 63.5 6826 -0.2 0.8 -8.0 3.2 3604 -0.6 0.8 3322 0.4 0.3 
Seagrass discontinuous 51.9 6944 -0.1 0.5 -8.3 2.6 3721 -0.4 0.4 3223 0.3 0.3 
*Spur and groove 5.5 613 -0.02 1.3 -4.6 6.5 343 -0.8 0.8 270 1.0 1.0 
Pavement w/sand channels 6.3 623 0.2 1.2 -3.2 5.7 313 -0.8 0.7 310 1.1 0.9 
Not classified 0.7 113 0.2 0.5 -2.0 2.0 34 -0.4 0.4 79 0.4 0.3 
Lower Florida Keys, Looe Key 
Total study site 19.0 1688 -0.3 0.8 -4.0 7.3 1361 -0.6 0.4 327 0.7 1.1 
*Individual or aggregate patch reef 0.1 14 -0.8 0.8 -3.5 -0.2 14 -0.8 0.8 - - - 
*Reef rubble 0.4 68 -0.7 0.8 -2.9 0.9 55 -0.9 0.6 13 0.3 0.3 
Seagrass continuous 3.6 285 -0.5 0.4 -3.1 0.4 264 -0.5 0.3 21 0.2 0.1 
Seagrass discontinuous 4.6 488 -0.5 0.5 -1.9 2.0 427 -0.6 0.3 61 0.3 0.3 
Pavement 2.2 198 -0.4 0.7 -2.2 1.9 151 -0.6 0.4 47 0.5 0.5 
Unconsolidated sediments 6.8 533 -0.4 0.7 -4.0 6.3 428 -0.6 0.4 105 0.7 1.0 
*Spur and groove 0.7 68 0.5 1.1 -1.4 4.2 21 -0.5 0.4 47 1.0 1.0 
*Aggregate reef 0.4 29 2.0 1.9 -1.4 7.3 1 -1.4 0.0 28 2.2 1.9 
Not classified 0.1 5 3.0 1.3 0.7 4.1 - - - 5 2.9 1.3 
St. Thomas, US Virgin Islands 
Total study site 116.9 49269 -0.3 0.9 -11.2 25.6 35332 -0.5 0.7 13937 0.4 0.9 
*Spur and groove 0.1 75 -1.1 1.6 -5.9 3.1 60 -1.6 1.2 15 1.1 0.9 
*Patch reef (aggregate) 0.4 163 -1.0 1.6 -5.9 4.9 138 -1.3 1.4 25 0.9 1.2 
*Linear reef 4.2 2244 -0.7 1.5 -11.2 7.0 1632 -1.2 1.4 612 0.7 0.8 
*Colonized bedrock 2.4 1968 -0.6 1.5 -8.3 6.1 1358 -1.2 1.2 610 0.9 1.0 
*Colonized pave.w/sand channels 1.5 591 -0.5 1.0 -5.7 4.3 438 -0.9 0.8 153 0.5 0.6 
Uncolonized pave. w/sand channels 0.1 41 -0.5 0.9 -3.0 0.9 27 -0.9 0.9 14 0.3 0.3 
Mud 1.7 1857 -0.5 1.1 -5.6 3.4 1262 -1.0 0.9 595 0.5 0.5 
*Scattered coral/rock in uncons. sed. 0.5 324 -0.5 1.3 -8.4 4.3 228 -0.9 1.2 96 0.5 0.7 
*Colonized pavement 4.7 3195 -0.4 1.0 -7.9 8.1 2249 -0.8 0.9 946 0.5 0.6 
*Patch reef (individual) 0.4 280 -0.3 1.1 -5.3 3.2 193 -0.8 0.8 87 0.7 0.8 
Seagrass 16.0 11113 -0.2 0.6 -7.5 13.2 7914 -0.4 0.6 3199 0.3 0.5 
Macroalgae 44.5 13973 -0.2 0.5 -11.1 4.0 10360 -0.3 0.5 3613 0.2 0.2 
Sand 1.6 961 -0.2 0.8 -4.2 3.9 571 -0.6 0.6 390 0.4 0.5 
Unknown 38.8 11992 -0.2 0.6 -8.6 11.5 8533 -0.3 0.5 3459 0.2 0.5 
*Reef rubble 0.02 1 -0.1 0 -0.1 - 1 -0.1 0 - - - 
Uncolonized pavement 0.1 33 -0.1 0.4 -1.2 0.7 20 -0.3 0.4 13 0.2 0.2 
Uncolonized bedrock 0.02 6 1.1 1.0 - 2.3 - - - 6 1.1 1.0 
Buck Island, US Virgin Islands 
Total study site 51.8 13894 -0.1 0.7 -8.6 6.8 7200 -0.5 0.7 6694 0.4 0.4 
*Patch reef (aggregated) 3.2 1086 -0.5 1.5 -8.6 6.8 629 -1.3 1.5 457 0.5 0.9 
*Patch reef (individual) 0.1 17 -0.3 0.5 -1.5 0.7 13 -0.5 0.4 4 0.3 0.3 
Unknown 1.8 551 -0.3 0.9 -4.9 3.5 326 -0.8 0.8 225 0.5 0.5 
*Colonized pave./w sand channels 27.3 6914 -0.1 0.6 -5.9 3.3 3809 -0.4 0.5 3105 0.3 0.3 
*Scattered coral/rock in uncons. sed. 4.5 1152 -0.01 0.6 -4.7 2.8 490 -0.4 0.6 662 0.3 0.3 
*Reef rubble 0.03 10 0 0.3 -0.5 0.5 5 -0.3 0.2 5 0.3 0.2 
*Colonized pavement 11.9 3286 0.01 0.5 -3.0 4.5 1529 -0.4 0.4 1757 0.3 0.3 
Seagrass 2.4 610 0.02 0.4 -2.2 0.9 270 -0.2 0.3 340 0.2 0.2 
Sand 0.4 88 0.1 0.6 -3.8 0.9 27 -0.5 0.8 61 0.3 0.2 
Macroalgae 0.1 26 0.2 0.5 -1.6 0.7 4 -0.6 0.7 22 0.3 0.2 
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*Linear reef 0.1 83 0.6 2.1 -3.0 5.7 43 -0.9 0.8 40 2.2 1.9 
Maui, Hawaii      
Total study site 84.5 27518 -0.8 1.5 -28.7 11.8 22111 -1.2 1.4 5407 0.7 0.9 
*Individual patch reef 0.1 166 -1.3 2.0 -7.4 4.9 140 -1.9 1.5 26 1.6 1.3 
*Coral reef and hardbottom 19.5 5610 -1.3 2.0 -16.7 8.3 4592 -1.8 1.8 1018 1.0 1.2 
Unknown 13.2 4548 -1.2 2.2 -28.7 9.2 3520 -1.8 2.1 1028 0.8 1.0 
*Spur and groove 2.1 369 -0.8 1.1 -9.2 2.7 300 -1.1 1.0 69 0.5 0.5 
*Aggregate patch reef 0.3 170 -0.7 0.8 -3.9 1.7 148 -0.9 0.7 22 0.6 0.5 
*Aggregate reef 12.8 3666 -0.7 1.1 -9.4 8.6 2892 -1.0 0.9 774 0.6 0.8 
Sand 22.5 8381 -0.6 0.8 -11.5 9.8 7272 -0.8 0.7 1109 0.5 0.7 
*Scattered coral/rock 0.04 17 -0.6 0.7 -2.1 0.9 15 -0.7 0.5 2 0.7 0.3 
*Coral pavement 13.5 4412 -0.4 0.9 -10.4 6.4 3120 -0.8 0.8 1292 0.5 0.6 
Pavement w/sand channels 0.4 158 -0.4 0.9 -4.3 1.8 105 -0.8 0.8 53 0.5 0.4 
Rubble 0.03 10 0.03 0.5 -0.5 0.8 5 -0.4 0.1 5 0.5 0.3 
Mud 0.005 4 0.2 1.3 -0.6 2.1 3 -0.4 0.2 1 2.1 0.0 
Notes: * = coral-dominated substrate. Uncons. sed. = unconsolidated sediment. Pave. = pavement. /w = with. Dashes indicate not 

applicable. Data points were excluded from habitat analysis where no habitat delineations were available. Total study site values 

include all data points. 
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Table 3. Volume change by habitat type 

Location Habitat 
area 
(km2) 

Gross erosion 
(Mm3) 

Gross accretion 
(Mm3) 

Net volume  
change 
(Mm3/study 
area) 

Area-normalized 
volume change 
(Mm3/km2) 

  Lower Upper Lower Upper Lower Upper Lower Upper 
Upper Florida Keys 
Total study site 241.1 -21.5 -69.2 7.1 31.3 -14.3 -37.9 -0.1 -0.2 
*Scattered coral/rock in uncons. sed. 0.2 -0.1 -0.1 0.00 0.01 -0.1 -0.1 -0.3 -0.7 
Pavement 17.0 -2.4 -6.6 0.8 2.4 -1.6 -4.3 -0.1 -0.3 
*Aggregate reef 11.8 -1.9 -4.5 0.8 2.3 -1.1 -2.2 -0.1 -0.2 
*Reef rubble 1.5 -0.2 -0.6 0.1 0.2 -0.1 -0.4 -0.1 -0.2 
Unconsolidated sediments 65.3 -4.1 -17.5 0.9 5.8 -3.2 -11.7 -0.05 -0.2 
*Individual or aggregate patch reef 17.2 -2.9 -7.1 0.6 2.1 -2.4 -4.9 -0.1 -0.3 
Seagrass continuous 63.5 -6.4 -18.7 1.1 8.5 -5.2 -10.2 -0.1 -0.2 
Seagrass discontinuous 51.9 -2.0 -9.8 0.7 6.0 -1.3 -3.9 -0.02 -0.1 
*Spur and groove 5.5 -0.8 -2.0 0.8 1.6 0.1 -0.3 0.01 -0.1 
Pavement with sand channels 6.3 -0.8 -2.2 1.2 2.2 0.4 -0.04 0.1 -0.01 
Not classified 0.7 -0.01 -0.04 0.03 0.2 0.02 0.1 0.03 0.2 
Lower Florida Keys, Looe Key 
Total study site 19.0 -1.7 -8.2 1.6 2.6 -0.1 -5.6 -0.01 -0.3 
*Individual or aggregate patch reef 0.1 -0.02 -0.1 0.00 0.00 -0.02 -0.1 -0.2 -0.6 
*Reef rubble 0.4 -0.1 -0.2 0.00 0.01 -0.1 -0.2 -0.2 -0.5 
Seagrass continuous 3.6 -0.2 -1.7 0.00 0.01 -0.2 -1.7 -0.1 -0.5 
Seagrass discontinuous 4.6 -0.5 -2.3 0.0 0.1 -0.5 -2.2 -0.1 -0.5 
Pavement 2.2 -0.2 -0.9 0.02 0.1 -0.2 -0.8 -0.1 -0.3 
Unconsolidated sediments 6.8 -0.7 -2.9 0.5 0.9 -0.2 -2.0 -0.02 -0.3 
*Spur and groove 0.7 -0.01 -0.1 0.2 0.4 0.2 0.3 0.3 0.4 
*Aggregate reef 0.4 0.00 -0.01 0.7 0.9 0.7 0.9 1.6 2.1 
Not classified 0.1 0.00 0.00 0.1 0.2 0.1 0.2 1.7 2.2 
St. Thomas, US Virgin Islands 
Total study site 116.9 -7.4 -29.1 1.4 7.5 -6.0 -21.6 -0.05 -0.2 
*Spur and groove 0.1 -0.1 -0.2 0.00 0.01 -0.1 -0.2 -0.8 -1.2 
*Patch reef (aggregate) 0.4 -0.2 -0.3 0.00 0.02 -0.2 -0.3 -0.4 -0.7 
*Linear reef 4.2 -1.3 -2.4 0.2 0.5 -1.1 -1.9 -0.3 -0.5 
*Colonized bedrock 2.4 -1.0 -1.8 0.2 0.4 -0.8 -1.3 -0.3 -0.6 
*Colonized pavement with sand channels 1.5 -0.3 -0.8 0.02 0.1 -0.3 -0.7 -0.2 -0.5 
Uncolonized pavement with sand channels 0.1 0.0 -0.1 0.00 0.01 -0.02 -0.05 -0.2 -0.5 
Mud 1.7 -0.6 -1.0 0.1 0.3 -0.5 -0.8 -0.3 -0.5 
*Scattered coral/rock in uncons. sed. 0.5 -0.1 -0.2 0.02 0.1 -0.1 -0.1 -0.2 -0.3 
*Colonized pavement 4.7 -0.9 -2.0 0.2 0.5 -0.8 -1.5 -0.2 -0.3 
*Patch reef (individual) 0.4 -0.1 -0.2 0.02 0.1 -0.1 -0.2 -0.2 -0.4 
Seagrass 16.0 -0.9 -3.6 0.1 0.9 -0.7 -2.7 -0.05 -0.2 
Macroalgae 44.5 -1.1 -9.8 0.1 1.9 -1.0 -8.0 -0.02 -0.2 
Sand 1.6 -0.1 -0.4 0.03 0.1 -0.1 -0.3 -0.1 -0.2 
Unknown 38.8 -0.6 -6.2 0.3 2.6 -0.2 -3.6 -0.01 -0.1 
*Reef rubble 0.02 0.00 -0.01 0.00 0.00 0.00 -0.01 -0.1 -0.5 
Uncolonized pavement 0.1 0.00 -0.01 0.00 0.01 0.00 0.00 -0.02 0.0 
Uncolonized bedrock 0.02 0.00 0.00 0.00 0.01 0.00 0.01 0.2 0.3 
Buck Island, US Virgin Islands 
Total study site 51.8 -2.3 -9.6 0.7 6.1 -1.6 -3.4 -0.03 -0.07 
*Patch reef (aggregated) 3.2 -0.9 -1.6 0.1 0.4 -0.8 -1.2 -0.2 -0.4 
*Patch reef (individual) 0.1 0.00 -0.01 0.00 0.00 0.00 -0.01 -0.03 -0.2 
Unknown 1.8 -0.2 -0.6 0.05 0.2 -0.2 -0.4 -0.1 -0.2 
*Colonized pavement with sand channels 27.3 -0.8 -5.0 0.3 2.9 -0.5 -2.1 -0.02 -0.1 
*Scattered coral/rock in uncons. sed. 4.5 -0.1 -0.5 0.00 0.6 -0.1 0.0 -0.01 0.01 
*Reef rubble 0.03 0.00 -0.01 0.00 0.00 0.00 0.00 -0.03 -0.1 
*Colonized pavement 11.9 -0.2 -1.4 0.1 1.6 -0.02 0.2 0.00 0.01 
Seagrass 2.4 -0.03 -0.2 0.00 0.2 -0.02 0.1 -0.01 0.0 

Biogeosciences Discuss., doi:10.5194/bg-2016-407, 2016
Manuscript under review for journal Biogeosciences
Published: 10 October 2016
c© Author(s) 2016. CC-BY 3.0 License.



27 
 

Sand 0.4 -0.01 -0.04 0.01 0.07 0.00 0.02 -0.01 0.1 
Macroalgae 0.1 0.00 -0.01 0.00 0.02 0.00 0.00 -0.02 0.0 
*Linear reef 0.1 -0.01 -0.03 0.04 0.05 0.02 0.02 0.4 0.3 
Maui, Hawaii 
Total study site 84.5 -55.8 -87.2 3.0 6.7 -52.8 -80.5 -0.6 -1.0 
*Individual patch reef 0.1 -0.1 -0.1 0.01 0.01 -0.1 -0.1 -0.9 -1.2 
*Coral reef and hardbottom 19.5 -23.3 -31.4 1.1 1.9 -22.2 -29.4 -1.1 -1.5 
Unknown 13.2 -15.0 -19.9 0.7 1.5 -14.2 -18.3 -1.1 -1.4 
*Spur and groove 2.1 -0.9 -1.7 0.03 0.1 -0.8 -1.6 -0.4 -0.8 
*Aggregate patch reef 0.3 -0.1 -0.2 0.00 0.02 -0.1 -0.1 -0.2 -0.5 
*Aggregate reef 12.8 -4.7 -9.4 0.3 0.8 -4.4 -8.7 -0.3 -0.7 
Sand 22.5 -8.5 -17.2 0.3 1.0 -8.2 -16.2 -0.4 -0.7 
*Scattered coral/rock 0.04 -0.01 -0.03 0.00 0.00 -0.01 -0.03 -0.3 -0.7 
*Coral pavement 13.5 -3.2 -7.2 0.4 1.3 -2.8 -5.8 -0.2 -0.4 
Pavement with sand channels 0.4 -0.1 -0.2 0.01 0.1 -0.1 -0.2 -0.2 -0.3 
Rubble 0.03 0.00 0.00 0.00 0.01 0.00 0.00 0.01 0.1 
Mud 0.005 0.00 0.00 0.00 0.00 0.00 0.00 0.02 -0.04 
* = coral-dominated substrate.          
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Table 4. Vertical error-analysis results. 5 

Study site Historical Data   Modern Data  VDatum   Study Site Totals 
 # paired 

points 
RMSESounding 
(m) 

T-test results 
(±, P) 

 RMSELidar  
(m) 

 RMSEVDatum 
(m) 

 RMSETotal  
(m) 

*1.65 x study site 
RMSETotal (m) 

UFK 38 0.23 +, 0.96  0.15  0.081  0.29 0.47 
STT 184 0.26 +, 0.81  0.135  0.114  0.31 0.52 
STC 29 0.32 +, 0.93  0.135  0.114  0.37 0.60 
Maui 46 0.13 +, 0.99  0.15  -  0.20 0.33 
Average - - -  -  -  0.29 0.48 
Notes: LFK was excluded from the error analysis because no adjacent points were separated by 0.5 m or less. 

For t-test results, + = accept H0. *1.65 x study site RMSETotal = 90% of variance. 
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Table 5. Horizontal shift analysis results. Un-shifted results are derived from the original point to DEM data sets, correctly 5 

aligned to horizontal datums, for each study site. Experimental data sets were created by shifting UTM northings and eastings 

of historical elevation XYZ data sets by plus or minus 10 m and recalculating volume change relative to unshifted LiDAR 

elevation data. 

Study site 
& relative 
location 

Net volume 
change 
(Mm3) 

% difference 
from un-shifted 
value 

Area- normalized 
volume change 
(Mm3/km2) 

% difference 
from un-shifted 
value 

UFK 
Un-shifted -37.9 - -0.16 - 
x + 10 m -41.7 10 -0.17 6 
x – 10 m -34.9 8 -0.15 6 
y + 10 m -36.6 3 -0.15 6 
y – 10 m -39.5 4 -0.16 0 
LFK 
Un-shifted -5.7 - -0.30 - 
x + 10 m -5.8 2 -0.31 3 
x – 10 m -5.4 5 -0.29 3 
y + 10 m -4.5 21 -0.24 20 
y – 10 m -6.7 18 -0.35 17 
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Figure 1. Elevation-change and habitat maps for the Upper Florida Keys (a and b) and Lower Florida Keys (c and d) over 68 

and 66 years, respectively. Elevation values are differences in meters between modern and historical elevation data (Zchange = 

modern elevation – historical elevation, see Tables S4 and S5). Negative numbers indicate elevation loss, positive numbers 5 

indicate elevation gain. Red and blue circles indicate areas of high erosion and accretion rates, respectively. Dashed lines = 

sub-regions. Habitat maps were modified from existing geo-databases (Table S1). 
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Figure 2. Elevation-change and habitat maps for the U.S. Virgin Islands. St. Thomas elevation-change over 48 years (a) and 

habitat (b). Buck Island elevation-change over 33 years (c) and habitat (d). Elevation values are differences in meters 

between modern and historical elevation data (Zchange = modern elevation – historical elevation, see Tables S6 and S7). 5 

Negative numbers indicate elevation loss, positive numbers indicate elevation gain. Red circles indicate areas of high erosion 

rates. Habitat maps were modified from existing geo-databases (Table S1). 
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Figure 3. Elevation-change and habitat maps for Maui, Hawaii. Elevation-change over 38 years (a). Habitat (b). Elevation 

values are differences in meters between modern and historical elevation data (Zchange = modern elevation – historical 

elevation, see Table S8). Inset shows magnified detail of the north central reef tract. Negative numbers indicate elevation 

loss, positive numbers indicate elevation gain. Habitat maps were modified from existing geo-databases (Table S1). 5 
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Figure 4. Mean annual elevation change calculated from total mean elevation change in meters (Table1) divided by the time 5 

range of historical to modern bathymetric data sets for each study site (Table S1). *SLR = global mean sea level rise of 3.2 

mm yr-1. 
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Figure 5. Projected water depth for the year 2100. Projected change in water depth by 2100 from combined impact of mean 5 

rates of seafloor elevation loss and rising sea level based on local (a) NOAA sea-level rise trends downloaded on August 4, 

2016 (http://tidesandcurrents.noaa.gov/products.html) and global sea level rise trends (b), see Table S9. *SLR = water depth 

due only to global mean sea level rise of 3.2 mm yr-1. 
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